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                                  SEPTEMBER 10 GENERAL MEETING 

 

Tuesday, September 10, 7:30 - 9:00 PM 

Westchester United Methodist Church 

Fellowship Hall 

8065 Emerson Ave., Westchester,  90045 

6:30 to 7:20 Social Time and an Informal Q & A 

Roundtable to Answer Individual Questions  

7:00 to 7:30 Refreshments 

  More info: www.lacspc.org or 310-398-0366 

LACS IS A MEMBER 

OF APCUG 
www.apcug2.org 

www.facebook.com/APCUG 

www.twitter.com/apcug 
www.youtube.com/apcugvideos 

LACS 

A Computer and 

Technology 

 User Group 

Topic: Cut the Cord: New Ways to Watch TV 

Speaker: Hewie Poplock 

Sarasota Technology User Group, Florida 

APCUG Speaker 

T his program will show various ways to 
watch TV shows over the air and over the 

internet with free and inexpensive alternatives 
to expensive cable or satellite TV. New equipment will 
save money and give you better program choices. He 
will also discuss using the internet for your home phone 
(VOIP). This talk will help you understand many of the 
newest possibilities for TV viewing and what to look for. 

Meet Our Presenter 

Hewie Poplock joined the Tampa Bay Osborne User 

Group and was amazed at how computer users helped 

each other. In 1987, he joined the Central Florida Com-

puter Society and was its President for four terms and 

Program Chair for many years. He is chair of its Win-

dows SIG (Special Interest Group) which gives a live 

remote monthly presentation to CFCS members and, 

via the internet, to other user group members. You can 

sign up for a monthly emailed newsletter for the meet-

ing links and Windows news at https://hewie.netwinsig/. 

Hewie recently joined the Sarasota Technology User 

Group. He was vice president of APCUG. Hewie is a 

former teacher, college instructor, business owner and 

manager, IT Manager and web designer. He is active in 

technology user groups and frequently speaks to 

groups. Hewie has tutorial videos on YouTube and rec-

orded windows SIG presentations on his website.  

An advocate for Chromebooks, Hewie maintains a 

Chromebooks 4 Seniors website at http://cb4s.net/.  

See Pages 2 and 3 for elec-

tion news for the 2020 LACS 

Board. Nominations will be 

taken from the floor at the 

September 10 meeting. We 

need candidates for a  

secretary and directors. 

WE NEED YOU! 

An International 

 Association of Technology 

 and Computer User Groups 

http://www.lacspc.org
http://www.apcug2.org
http://www.facebook.com/APCUG
http://www.twitter.com/apcug
http://www.youtube.com/apcugvideos
https://hewie.net/winsig/
http://cb4s.net/
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FROM YOUR PRESIDENT / EDITOR 

It is Election Time! 

See page 3 to meet the candidates for 

the officers and directors for the 2020 

LACS board.  

The candidates will be introduced at the 

September 10 general meeting, and 

there will be nominations from the floor. 

We still need a secretary and at least 

two directors.  

You may nominate yourself!  

The new board members will take office 

in January 2020. They may come to the 

board meetings before then to get 

acquainted with the procedures. 

If there are any contested positions, we 

will mail a ballot to all members to be 

returned to our mailbox by October 12, 

the Friday before the October general 

meeting. If there is no contest, we will 

pass a motion at the September meeting 

to elect all the candidates.  

Change of Date for the 

October General Meeting 

Because of the Yom Kippur holiday on 

October 8, the October meeting will be on 

October 15. Please mark your calendars 

so you don’t forget. A blessed Holiday to 

our Jewish members. 

APCUG Photo Contest 

If you are on the lacspc mail list, on  

August 19 you received a notice of the 

2019 photo contest. Please consider en-

tering. APCUG people do a lot of work to 

put on the contests. It’s disheartening if 

only a few enter. If you did not receive it, 

email Leah Clark for a copy. If you would 

like to be on the list, please see the  

column to the right.  

Join LACS Mail Lists 

It has come to our attention that some LACS 

members are not on our two main mail lists. 

The access to these two lists are among the 

benefits of membership. You are really missing 

out if your not on them. Only members can 

join, so there is no privacy concern. There are 

options on how to receive email, for example, 

you may opt for a weekly digest.  

When you joined LACS you should have re-

ceived two invitations to join the lists, but there 

were some mix-ups after our former list man-

ager died. So now we want to make sure all 

members have access.  

Please distinguish  between the two groups. 

lacspc@yahoogroups.com is for official LACS 

business, such as meeting announcements, 

and other LACS announcements. It is moder-

ated and accepts attachments. “Moderated” 

means that every message is reviewed for ac-

ceptability before it goes out. 

 lacslist@yahoogroups.com 

This unmoderated email list is for all other 

computer-related messages from members to 

members. It works well for solving problems 

and sharing information. It does not accept at-

tachments. Many people will see your question 

and respond, and you may be able to help an-

other member.  

There are several ways to join the lists or 

make changes. See the “Join Our Mail Lists” 

on page 8 of this issue. If you receive an invi-

tation to join, answer it within a week. If you 

get two invitations, answer both of them sepa-

rately. If you have any trouble, contact  Steph-

anie Nordlinger via ContactUs (at)LACSPC.org 

or via her email address. Our website has 

forms for changing your contact information 

under “Member Forms.”  

If you have an Yahoo ID, you can search and 

read old messages and make changes in your 

account. Contact Stephanie if you want help  

getting an Yahoo ID. 

mailto:lacspc@yahoogroups.com
mailto:lacslist@yahoogroups.com


  
 

 

September - 2019       User Friendly  —  The Los Angeles Computer Society        Page 3 

President, Leah Clark 

Incumbent 

During the 22 years I have 

been a member of LACS, I 

have been Welcome Chair, 

SIG leader, Director and Sec-

retary. I am currently the President and 

Newsletter Editor. Through all this, I have 

constantly been learning. After a year as 

president, I may have learned enough to do 

it again! I earned a BA in microbiology at 

UCLA and worked as a Clinical Laboratory 

Scientist at UCLA for 43 years. I'm busy with 

the DAR, gardening, needlework, neighbor-

hood committees, my church, and my dog. I 

hope LACS will continue to serve the needs 

and interests of its members. I welcome 

member’s help to accomplish this. 

Vice President, Stephanie Nordlinger 

Incumbent 

I like this job because the VP 

helps to select and invite 

general meeting speakers 

and may stand in for the 

president. I was a member of 

the UCLA PC Users Group 

(mid-1980s-1991) and helped to incorporate 

LACS in 1991. I have served as President, 

VP, Editor, Counsel, Smartphone SIG Lead-

er, product review coordinator, product re-

viewer, etc. I am a semi-retired Los Angeles 

attorney with degrees from UCLA (Political 

Science), Berkeley (Economics) and Loyola 

University School of Law/ Los Angeles. My 

aim is to have varied and stimulating pro-

grams to interest and inform many people. I 

welcome your input. The VP provides infor-

mation to the members who publicize our 

meetings. I try to find ways to bring new 

people in and encourage them to be active. 

My involvement in LACS teaches me new 

ways to use PCs and other technologies ef-

fectively. 

NOMINEES FOR THE LACS BOARD 

T hese are the nominees we have so far for 

the 2020 LACS board. There are still 

openings for  secretary and at least two direc-

tors. The secretary takes the minutes at the 

monthly board meeting on the last Monday of 

the month. A director attends the board meet-

ing, offers suggestions, and votes on LACS 

policies. To keep LACS operating, please vol-

unteer for one of these positions. 

Treasurer, Gavin Faught  

Hi there. My name is Gavin 
Faught, and I am running to 
become Treasurer of LACS. I 
have been a member for 
about a year now and am 
ready to take it to the next lev-
el. I do have leadership experience. At UC 
Davis, my alma mater, I was Vice President 
for the fraternity Phi Beta Lambda and at 
CSU – Sacramento, I was Treasurer for the 
Accounting Society. Computer topics that 
interest me are Information Technology, cy-
bersecurity, and programming. My hobbies 
include Thai boxing and playing and record-
ing music. I am looking forward to making 
LACS the best it can be. 

 

Director, Paula Van Berkom 
Incumbent 

I have a certificate of com-

pletion in Computer Science 

from WLA College. As a 

member of LACS, I have tak-

en part in the Basics & Be-

yond and other SIGs. I have 

volunteered teaching computers to seniors 

at Emeritus Santa Monica College and at 

the computer Lab at Culver City Senior 

Center. I have learned much from  LACS 

and have decided to share all this 

knowledge with the community by returning 

to the Board for another term as Director. 

As a member, I plan on reaching out to our 

members and to other computer users to 

expand our scope of activities. I trust that 

you share my confidence in making LACS a 

premier computer user group. 
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GENERAL MEETING REPORT 
August 13, 2019 

Buying and Selling on the Internet 

By Leah Clark, LACS Editor and President 

Speakers: Mark Presky, LACS Director 

                 Marsha Saltman 

text, or phone you.  

To decide on a price, look on craigslist, eBay 

and other sites to see what others are asking 

for similar items. Consider how many people 

are selling that item. A rule of thumb is to nev-

er sell an item for more than half of what you 

paid for it. 

eBay is an auction site, but it also has a “Buy 

It Now” function with a fixed price. You can 

check a box allowing a lower offer. Mark 

quipped about an item that sold after he 

raised the price! Sometimes you can negotiate 

the price with a customer.  

Several members had helpful suggestions. 

One thinks it helps to know how to buy online, 

before trying to sell. Amazon has good buys 

on used books. Another stressed the im-

portance of comparing the price for the same 

item on more than one site, and also to com-

pare the shipping cost. Check the seller’s rat-

ings. A woman was concerned about having a 

stranger deliver something to her home when 

she is alone. You can arrange to meet in a 

public place or, if it is a large item, plan to 

have someone with you at the time of pick-up. 

Let the buyer know how the item will be 

shipped – in an envelope or box, by USPS 

(first class or Priority), FedX, or UPS. 

To figure shipping costs for eBay, you can en-

ter the type of box or envelope, the dimen-

sions, and weight, and click the box to calcu-

late. When you go to Help on eBay and Ama-

zon, you can get a live person to answer your 

question.  

There is no fee to become a member on eBay 

or craigslist eBay charges fees to the seller 

when items are sold. There are no fees for 

sales on craigslist.  

To avoid scams require cash payments, never 

deliver an item, and never sell outside of eBay 

or other sites.   

You can listen to the podcast of this presenta-

tion for more information at  

https://www.lacspc.org/category/audio-files/ ❖ 

M ark and Marsha have accumulated ex-

perience selling online, and it has be-

come a hobby. Mark likes to tinker with 

things, so if he finds an item, like a vacuum 

cleaner or leaf blower, he’ll clean it up and 

put it on craigslist (https://craigslist.org). An 

old file cabinet can be turned into a dinner 

out. Most of what he has sold are things he 

no longer uses or has upgraded, and items 

from his parents’ estate, including artwork 

and furniture.   

Craigslist  is probably the easiest way to 

start, but there are certain general rules. 

There are many different venues, including 

craigslist, eBay, Amazon, OfferUp, and 

NextDoor. Each has its niche, advantages 

and disadvantages. When you go to any of 

these sites, read the policies. eBay is trying 

to protect buyers and wants to be sure the 

item is described accurately and that the 

sellers send it when they agreed to, so that 

buyers are not taken advantage of. Sellers 

should take lots of good photos. Mark and 

Marsha agree that a smartphone is best for 

taking pictures because it’s easy to put them 

on the computer to send them. eBay needs 

a larger file size than other sites. You’ll get 

positive feedback from the buyers when you 

deliver items that are as you represented 

them. Positive feedback will encourage oth-

er buyers to buy from you. If the buyer is un-

happy, they may force you to pay for return-

ing it, and you will get negative feedback.  

You can set up an account on craigslist or 

eBay, but that isn’t necessary if you sell only 

an occasional item. Mark showed us how to 

enter information on craigslist – owner, loca-

tion, category, add photos, etc. You can 

choose to have potential customers eMail,  

 

https://www.lacspc.org/category/audio-files/
https://craigslist.org
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stores at comparable prices. Since travel 

agents are no longer readily available, you 

need to do much of your research and pur-

chasing of airline tickets and travel online.  

Do not assume that Amazon’s or any other 

online price is cheaper than buying locally or 

from another website. Search various web-

sites and always consider the cost of ship-

ping, if any. Even Amazon Prime is a cost if 

you don’t use it for entertainment. Click on 

the “coupons” button even if you don’t know 

of any you are entitled to. I was surprised 

and pleased to find a $10 coupon applied to 

my J.C. Penny’s purchase, which offset the 

$8.50 shipping fee. 

I bought my new Windows 10 computer 

from Dell.com because I could specify ex-

actly what I wanted and because I had a 

good experience with my previous Dell pur-

chase. Cheaper deals were available, but 

they would usually provide less speed and 

capacity or charge me for something I didn’t 

want. Still, there were glitches: what the 

website called a “tower” turned out to be a 

“mini-tower” which had the same space and 

ports. Also, I had four Fed-Ex delivery dates; 

my computer arrived five days earlier than 

originally promised. 

Websites contain lots of data, and some of it 

is inevitably wrong. Or you may accidentally 

choose something other than what you were 

about to buy earlier. The main non-financial 

problem with buying online is not getting 

what you expect. I ordered a laundry bag in 

an attractive color, but the one that arrived 

was nowhere near the color shown on the 

website. I returned it and bought one locally 

so that I could tell what I was getting. I have 

had the same problem with shoes and cloth-

ing. Shortly before an international trip, I 

bought two pair of walking shoes. They ar-

rived as a man’s medium (size D) instead of 

a woman’s medium (size B). I returned one 

pair but had to keep the other because I 

needed it for my trip. Similarly, I thought I 

 

 

 

 

 

 

 

                 

ONLINE SHOPPING 
By Stephanie Nordlinger  

LACS Vice President 

O nline shopping is useful, 

but it has its hazards. If 

you are not careful, you may 

not get a bargain or even what 

you expected to get when you 

expected to get it. Be awake and alert when 

you are shopping. Take your time.  

Make purchases only on secure, authenticated 

websites. Look in the address bar for a URL 

beginning with “https//” and the rest of the URL 

should clearly be a known party, or at least 

one that you can research. Don’t click on a link 

in an email without running your mouse over it 

to see if the address is short and reasonable. 

The link will go to the first website shown by a 

domain name. If that’s not the proper com-

pany, do not use this URL. 

You can check out a seller in various ways. 

Amazon sub-sellers and Yelp.com have rat-

ings from previous buyers. You can also 

Google a corporate name or brand or check 

the local Better Business Bureau for that com-

pany’s rating. I look for independent reviews of 

products, especially technical products. You 

may want to check the seller’s privacy policy to 

see if it will share information you provide with 

other marketers. Business and professional 

licensees and companies can be checked on 

governmental websites. No street address and 

foreign addresses on websites are suspicious. 

Street addresses can be checked on Google 

Maps or something similar: are they real or 

just a mailbox? You should deal with honest, 

solvent people and companies that can be 

found (and possibly sued) if anything goes 

wrong. 

The best things to buy online are hard to find 

or configure otherwise and specific things  

(e.g., a particular year and version of Quick-

en). Things that are hard to find include out-of-

print books (e.g., on Amazon or eBay) and  

anything that isn’t readily available at retail 
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chose nylon panties online, but they came in 

cotton. I didn’t notice this in the sales confir-

mation email (read it promptly!) and discard-

ed it too soon. Both items had the same 

number on the website; it turned out to be a 

style number, not an unique SKU. I was able 

to exchange the panties at a local store, but 

I had to wait another week for the ones I 

wanted to arrive. You should hold onto your 

confirmation emails at least until the time for 

returning the item is past. I might not have 

had to pay the transportation charge if I 

could have shown that the error was theirs, 

not mine. 

Financially, you should: always use a private 

computer and network to access the net for 

shopping purposes. (Some people use 

smartphones, but I don’t.) The computer 

should be properly maintained (software up-

dated, working anti-malware software, etc.). 

Use a PayPal account or a credit card, nev-

er a debit card. Under the federal Fair Credit 

Billing Act, you can dispute bad charges on 

a credit card. While technically limited to dis-

putes involving $50 or more, the major credit 

card companies will accept any amount if 

you have a good reason because they want 

your business. Debit cards don’t have this 

protection. Don’t provide information that 

isn’t necessary to complete the transaction, 

and don’t provide it by phone unless you 

know the other party or you call a recog-

nized number.  

Never accept an amount that is more than 

what you are due with the request that you 

send the other party the difference. This is a 

standard scam: the amount received will dis-

appear, and your check or Venmo (a digital 

wallet) transfer will clear. 

Always be cautious: if something is too good 

to be true, it probably is. If the price is less 

than at other places, is there something 

missing? When buying a monitor, I discov-

ered that a store had the same model but 

with a shorter warranty than the manufactur-

er normally provided. This is a choice, not a 

bargain. 

If the vendor won’t treat you properly, complain 

to at least one appropriate entity - e.g. Amazon 

or eBay (if the transaction took place there) or 

the Federal Trade Commission’s Consumer 

Complaint website at 

https://www.ftccomplaintassistant.gov/,  

the BBB, the company’s Facebook page, etc. 

Such complaints will protect all of us. ❖ 

IS THERE A BETTER GIFT ONE CAN 

GIVE THAN MONEY? 
By Jerry Heaton, Past Editor 

Central Kentucky Computer Society 

June 2019 issue, CKCS newsletter 

www.ckcs.org 

jerheat (at) gmail.com 

I f it is not money, what is it? It is your time – 

volunteering your time.  

Before you say, “I’m too busy to do that,” you 

are probably wrong! Everyone, particularly re-

tired persons, has some idle time. You ask, 

“why would I want to volunteer?”  

Let me give you a few reasons.  

• When you volunteer, you help other people, 

other groups, or organizations. People will 

appreciate you and thank you.  

• It's a great opportunity to increase your 

skills and learn new ones.  

• You will meet and know new friends. 

• You exercise those brain cells, your whole 

body, and you eliminate boredom.  

• You are your own boss and decide how 

much, or how little, you want to do.  

• You can set your own goals.  

• You can pick your own schedule.  

• You get much satisfaction from completing 

and doing a good job.  

https://www.ftccomplaintassistant.gov/
http://www.ckcs.org
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sonal device or an Amazon Echo. There is a 

free version of the Plex Media Server app and 

various paid versions which offer additional 

features. I am using the free version of Plex 

Media Server in conjunction with my Playon 

(www.playon.tv) app to record streaming vide-

os from free services such as Tubi, Prime Vid-

eo, the Roku Channel and many paid services 

you may subscribe to. 

You can enable the Plex skill on your Amazon 

Echo smart speaker by opening the Alexa app 

on your computer or mobile device and looking 

for skills on the list on the menu on the left of 

your screen, select and then enter Plex in the 

search box. With your Plex media server on 

your same network and configured properly 

you can say “Alexa, ask Plex to play (artist, 

song or album). I am still organizing my music 

collection, but I am amazed at how the Plex 

skill can locate specific songs or artists multiple 

folders deep. You can also add a Plex channel 

to your Roku device and watch movies, view 

photographs, and play music stored on your 

Plex server. 

While this may not be for everyone since it re-

quires some “tweaking,” it is a challenging task 

that lets you play your music collection on your 

Amazon Smart speakers. ❖ 

(Continued on page 17) 

• You can decide to do more or less, and 

you can quit anytime, preferably with some 

notice.  

What are you doing today for your neighbor-

hood, your community, an organization or the 

country, or people in general?  

Where would you look to volunteer? There are 

so many places. May I suggest one close by 

you might consider? Your computer club. 

There are many opportunities.  

Think about it. There are plenty of places to 

start. You will feel better about yourself if you 

volunteer. It may be the best thing you have 

done in months or maybe years!   ❖ 

NEW AMAZON ALEXA SKILL (PLEX) 

By Jeff Wilkinson 

Sun City Summerlin Computer Club, NV 

www.scscc.club 

pres.scscc (at) gmail.com 

I n a constant search for new things to try, I 

came across a new Amazon Alexa skill that 

I thought would be of interest to club  

members. 

Requesting music on an Amazon Echo smart 

speaker or an Echo Dot always seems to get 

an invitation to subscribe to more songs than I 

could ever listen to, for a monthly fee. Since I 

have a CD collection of the artists I enjoy, I’ve 

avoided signing up. The problem is – how do I 

play my music collection on my Amazon Echo 

smart speakers? I began looking for a solution 

and came across an Alexa skill that makes 

use of my Plex (www.plex.tv) media server. 

What, you ask, is a Plex media server? In my 

case, it’s an always-on Windows 10 PC that 

resides on my network and has multiple drives 

with media such as music, movies, and pho-

tos. The Plex media server organizes my mu-

sic, photos, and movies from various locations 

on my network and streams them to other de-

vices such as a television, computer or per-

WYSIWYG WEB WATCH  
by Paul Baecker, Editor 
Sterling Heights Computer Club, MI 
WYSIWYG, June 2019 
www.sterlingheightscomputerclub.org 

webwatch (at) sterlingheightscomputerclub.org 

T his column attempts to locate sites con-

taining valuable, amusing, and free con-

tent, with no pressure to purchase anything. 

Why do some web site addresses start with 

WWW2? 

https://www.maketecheasier.com/sites-with-

www2  

Find wood imperfections with mineral spirits  

(2-min. video). 

http://www.playon.tv
http://www.scscc.club
http://www.sterlingheightscomputerclub.org
https://www.maketecheasier.com/sites-with-www2
https://www.maketecheasier.com/sites-with-www2
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WELCOME ALL 

George Wolkon, LACS Database Manager  

     New Members (0) 

               Renewals (12) 

    Ros Cirlin                                                                    Michael Price 

    Paul Cooley                                                       Mildred Rucker 

   Ian Cowan                                                               Regina Sims 

    Stanley    Epstein                                   Robert Swarthe 

    Lee Freehling                                            Betty Weatherspoon 

    William Oppenheim  *    Ronald Wisansky * 

                                                                            * Contributor 

 

         FIX YOUR PC FOR FREE? 

Jim McKnight has an open  

offer to all LACS members to  

diagnose, repair, disinfect, or  

upgrade members' PC’s for 

free. 

There are certain limitations to Jim’s offer, 

so see the details by clicking the “Fix my 

PC for Free?” link at www.jimopi.net. 

Non-members can wisely invest in a one-

year new Regular LACS membership 

($40.00), and Jim will fix your PC problem, 

too. Contact Jim for specific considerations. 

LACS IS ON TWITTER 
  

On Twitter, follow us at: 

https://twitter.com/

LA_CompSoc or click on this icon to 

see what's there.   

 

LACS NOTICES 

 

LACS HAS JOINED MEETUP 

Our Meetup group is called:  

"Los Angeles Computer Society and  

Technology Meetup." 

Please join and RSVP for our general 

meetings - it's free. Go to http://

www.meetup.com/Los-Angeles-Computer-

Society-and-Technology-Meetup/ or click 

on this icon.        Then click on "Join 

Us."   

 

HOW TO CHANGE YOUR CONTACT 

 INFORMATION 

Go to www.lacspc.org. Click on Member 

Forms in the bar under the picture. Under 

Membership Update, select Click Here to 

select either the DOC or PDF form. Fill it 

out and bring it to a meeting, mail it, or 

email your changes to membership (at) 

lacspc.org.  

 

LACS WEBSITE 

www.lacspc.org posts current and back 

copies of the color version of User Friendly, 

calendar information, and podcasts of most 

of our general meetings. There is also a bi-

annual index to past issues on the website. 

Check the menu on the right side. 

RIDE SHARING 

If you need a ride to a General Meeting, or 

if you are able to give a ride, please contact  

Freda Sanders at 323-230-3278. 

JOIN OUR MAIL LISTS 

All you have to do to join our lists is send 

your name only in the message body of an 

email from the address you want LACS to 

use to  

lacspc-subscribe (at) yahoogroups.com 

and to  

lacslist-subscribe (at) yahoogroups.com 

These lists are for members only.  

Lacspc is for official LACS business.  

Lacslist is for any other computer-related 

messages and questions.  

http://www.jimopi.net
https://twitter.com/LA_CompSoc
https://twitter.com/LA_CompSoc
http://www.meetup.com/Los-Angeles-Computer-Society-and-Technology-Meetup/
http://www.meetup.com/Los-Angeles-Computer-Society-and-Technology-Meetup/
http://www.meetup.com/Los-Angeles-Computer-Society-and-Technology-Meetup/
http://www.lacspc.org/
http://www.lacspc.org/
https://twitter.com/LA_CompSoc
http://www.meetup.com/Los-Angeles-Computer-Society-and-Technology-Meetup/
mailto:lacspc-subscribe@yahoogroups.com
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GENERAL MEETING SNACK SCHEDULE 

By Sylvia Q. Davis Hospitality Chair 

Refreshments and socializing will be at 

7:00. The meeting starts at 7:30. Please 

bring refreshments at 7:00.      

September 10.....O through S 

October 15..........T through Z 

November 12 ..... A through D 

December 10.......Holiday Party 

 

Bring finger-food  

treats such as fruit, 

veggies, nuts, cook-

ies, cold drinks and 

the like. 

 

LACS provides hot 

drinks. 

See your email for updates and reminders. 

GENERAL MEETING PRESENTATIONS 

September 10: Cut the Cord: New Ways to    

                                                                                      Watch TV 

October 15: Protecting Your Digital Life 

November 12: Windows 10 Topics 

December 10: Holiday Party 

 

Note: This schedule is subject to change.  

Check email, User Friendly and our website 

for updates, but mark your calendar now. 

PODCASTS 

Listen to the podcasts of our general meet-

ings. Go to http://www.lacspc.org/category/

audio-files/. Click on the session you want 

to hear.  

 LACS CALENDAR 

General Meeting 
Date: Tues, September 10, 2019 

Time: 7:30 P.M. 

Where: Westchester United Methodist   

 Church, Fellowship Hall.  

8065  Emerson Ave. Westchester, L.A. 90045 

 

LACS Board Meeting 

Date: Monday, September 30, 2019 

Time: 7:00 P.M. 

Where: At the home of Charlotte Semple 

Contact a board member for her address.  

LACS members are invited to attend. 

 

No Special Interest Group (SIG) meeting  

is scheduled for September. 

 New SIGs can be created if there is sufficient 

interest and leadership. 

      Please contact the board to make your  

     wishes known, or to offer ideas or help.  

 

September 1:           Islamic New Year 

September 2:          Labor Day 

September 8:         Grandparents Day 

September 10:        LACS General Meeting 

September 11:     Patriot Day 

September 23:      Autumn Begins 

September 29:   Rosh Hashanah 

September 30:     LACS Board Meeting 

      

  

          

          

USER FRIENDLY BACK ISSUES 

To see back issues of User Friendly, go to 

http://www.lacspc.org/category/user-

friendly/.  

Celebrate 

Grandparents 

http://www.lacspc.org/category/audio-files/
http://www.lacspc.org/category/audio-files/
http://www.lacspc.org/category/user-friendly/
http://www.lacspc.org/category/user-friendly/
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MEMBERS HELPING MEMBERS 

LACS members volunteer to help other members solve hardware and software problems by 

telephone during the hours listed below. Select the topic from the list and then call a person 

whose number is listed next to it. Or you may use a Helper’s e-mail address, found in your 

LACS Roster. We hope that you find this free service useful. If you are experienced using 

a particular program or know a topic, please volunteer to be a consultant. You don't 

have to be an expert. To volunteer for this list or to make corrections, please email Leah 

Clark at <Leahjc (at) sbcglobal.net> or call her at 310-677-2792. More Quick Consultants, 

and more categories are always needed. You may decline or postpone a call if it comes at 

an inconvenient time.  

Adobe Creative Suite: PDF,  

   InDesign, PhotoShop, etc. - 17 

Android Smartphones - 5 

Apple devices - 15 

Anti Malware and Backup - 5,12  

Digital Imaging, Editing - 8 

Digital Photography - 8 

Dragon Naturally Speaking - 4 

Genealogy - 5 

Hardware - 12 

Linux - 11 

Lotus Word Pro, Approach - 12 

Mozilla Firefox  - 12 

MS Excel - 3, 5, 15  

MS Word - 3, 4, 10 

MS Outlook - 5, 15, 17 

MS PowerPoint - 15 

MS Publisher - 7 

      Open Office - 16 

Photoshop - 17 

QuickBooks -18 

Quicken - 3, 5 

Thunderbird - 12 

Utilities - 5, 12 

Visual Basic - 13 

Websites - 13 

Windows 7 - 16 

Windows - 5, 12 

No. Name
Preferred Phone 

for Calls
  From       To

3 Wilder, Joan 310-472-8445 9:00 AM 9:00 PM

4 Hershman, Irv 310-397-9453 11:00 AM 11:00 PM

5 Nordlinger, Stephanie 323-299-3244 10:00 AM 7:00 PM

7 Clark, Leah 310-677-2792 7:00 AM 5:00 PM

8 Silverstein, Elliot 310-670-1544 10:00 AM 10:00 PM

10 Beckman, Loling 310-471-7893 10:00 AM 6:00 PM

11 Hughes, Bill 424-259-1818 Any Any

12 McKnight, Jim 310-823-7829 8:00 AM 7:00 PM

13 Ialongo, Gilbert 310-641-7906 9:00 AM 5:00 PM

15 Van Berkom, Paula 310-398-6734 9:00 AM 5:00 PM

16 Johnson, Carol 310-372-8535 10:00 AM 9:00 PM

17 Rozek, E. J. 310-823-3811 Noon 8:00 PM

18 Semple, Charlotte 310-398-5052 M-F 9:00 AM 5:00 PM
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OFFICERS, DIRECTORS AND LEADERS 

                 Website                        www.lacspc.org                                                           Newsletter Editor                 editor (at) lacspc.org 

                 Voice Mail          1-310-398-0366                                                           Webmaster                                                  sitemaster (at) lacspc.org 

                E-mail                                 ContactUs (at) lacspc.org           Change of Address        membership (at) lacspc.org 

     The ContactUs (at) lacspc.org address goes to our president and vice president.  

If the message is for another officer or member, they will forward it to the correct person.  

To contact other officers, directors, leaders, or members directly, members may use our 

roster for phone numbers   and e-mail addresses. 

      Title Name Term Telephone

President Leah Clark 2019 310-677-2792

Past President Stanley Johnson 2019 424-216-6984

Vice President Stephanie Nordlinger 2019 323-299-3244

Secretary Stanley Johnson 2019 424-216-6984

Treasurer Charlotte Semple 2019 310-398-5052

Director Paula Van Berkom 2019 310-398-6734

Director George Wolkon 2019 310-459-2671

Director Open 2019

Director Open 2020

Director E. J. Rozek 2020 310-823-3811

Director Howard Krivoy 2020 310-717-7465

Director Mark Presky 2020 310-398-0366

APCUG Rep. Leah Clark 310-677-2792

Car Pool Coordinator Freda Sanders 323-230-3278

Change of Address George Wolkon 310-459-2671

Corporate Counsel Stephanie Nordlinger 323-299-3244

CCSC Computer Lab Loling Beckman 310-471-7893

Greeter Freda Sanders 323-230-3278

  Assistant Greeter Penny McKnight 310-823-7829

Hospitality Chair Sylvia Davis 213-924-4927

  Asst. Hospitality Chair Open

Membership Database George Wolkon 310-459-2671

Newsletter Editor Leah Clark 310-677-2792

Program Chair Stephanie Nordlinger 323-299-3244

    Assistant Program Chair Open

Publicity - Press Mark Presky 310-398-0366

Publicity - Online Media Stanley Johnson 424-216-6984

Quick Consultants Leah Clark 310-677-2792

Webmaster Paula Van Berkom 310-398-6734

http://www.lacspc.org/category/audio-files/
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TWO WAYS TO ADD STYLE TO A 

WORD DOCUMENT 

By Nancy DeMarte, 1st Vice President  

Sarasota Technology Users Group, FL 

STUG Monitor, June 2019   

www.thestug.org 

ndemarte (at) verizon.net 

M icrosoft Word is loaded with features 

that give style to documents. “Style” in 

this case means modifying the look of text 

and paragraphs. To do this, many users 

change the font or font size, add effects like 

bold or color and maybe change the space 

between lines. These changes are made 

one at a time and can be time-consuming. 

Plus, you’ll have to do it again the next time 

you want that style.  

There are tools, however, that add style in 

easier and more coordinated ways. The first 

one is on the Home tab > Styles group. 

This gallery contains what could be called 

“Style Parts” because they add style to parts 

of documents like titles and headings. The 

other style-adding feature is the Document 

Formatting group on the Design tab. This 

gallery lets you apply a group of stylistic fea-

tures to a document all at once. These are 

called “Style Sets.” Here are a few tips for 

using Style parts and Style sets.  

Style Parts 

The Styles group on the 

Home tab offers several 

styles which can be ap-

plied to parts of docu-

ments or used to create a 

special kind of  document, 

like a company or club logo. To see the en-

tire Styles gallery, click the More icon at the 

right end of the Styles group. Let’s say you 

have a document with headings above each 

paragraph, as this article has. You would like 

to give them a different appearance from the 

rest of the text. To preview how some op-

tions would look, select your first heading 

and move your mouse pointer over the styles 

in the gallery to see how they change the 

heading. When you find one you like, click it to 

apply the style to the first heading.  

But what about all the other headings in your 

document? This is where Format Painter can 

help. Select the heading to which you just ap-

plied a style. Then double click Format Paint-

er on the Home tab > Clipboard group to 

keep Format Painter enabled. Drag your 

mouse across each of the remaining headings 

to apply the same style as the first one. When 

done, click Format Painter once to turn it off 

and save the document. I created and applied 

a style to the headings in this article as an ex-

ample. It has a different font, font size, and 

color from the rest of the text.  

Modify or Create a New Style  

Sometimes, you won’t find the style part you 

want in the gallery. This is when you can 

change a gallery style or make your own. To 

create a new style and add it to the gallery for 

future use, open a document and select a 

heading. Using the tools in the Home tab > 

Font group, make your changes. With the 

newly styled text selected, click the More icon 

and then click Create a Style to open the 

Create New Style from Formatting’ box.  

 

 

 

 

 

 

Give the new style a name that relates to its 

features and click OK. Your new style will ap-

pear in the Styles gallery. I named my head-

ing, “Blue Antique Heading,” based on the font 

I used. If you don’t find your new heading 

style in the gallery, click the More icon again, 

click Apply Styles and then click the new 

heading style name. Now you should see it in 

the gallery.  

http://www.thestug.org


  
 

 

September - 2019       User Friendly  —  The Los Angeles Computer Society        Page 13 

 

Style Sets:  

You can apply a group of style features to a 

whole document at once using Style Sets. This 

includes features on the Home tab in the Font 

and Paragraph groups. In Word version 2013 

and later, Style sets are found on the Design 

tab. Open this tab and click the More icon at 

the right end of the Document Formatting 

group to see the Built-In style sets.  

Preview how these would look on your docu-

ment by clicking anywhere in the document 

and moving your mouse pointer slowly over 

the gallery. Click a set to apply it to your docu-

ment. If you change your mind, remove the 

style by clicking the Undo icon (a left-curving 

arrow at the top left above the ribbon) or 

pressing Crtl+Z on the keyboard.  

For those with Word 2007 or 2010, the steps 

differ a bit. Click the Home tab, and in the 

Styles group, click Change Styles, then point 

to Style Set. Preview it the same way as de-

scribed above. Then click a style set to apply it 

to your selected document.  

Set a Style Set as Default 

The default style set in Word is called Normal. 

This means whenever you type in a blank doc-

ument, all the features of the Normal style set 

will be used. If you wish to modify the Normal 

style, make your changes, but give it a new 

name, which will leave the Normal style set  

intact. We do this so it doesn’t cause a prob-

lem when you open older documents.  

Microsoft has changed its Normal style 

properties over the years. (For example, Ari-

al was at one time the default font; now it’s 

Calibri.)  

You can choose any Style set to become 

the default. First, apply all the features you 

want. Then preview how it would look and 

add it to the Document Formatting gallery. 

Finally, click its gallery thumbnail, and click 

“Set as Default” which appears at the right 

end of the Document Formatting group. 

Now all new documents will be formatted 

according to your default Style set. You can 

change the default style at any time.  

The way to master Styles is to start small, 

such as applying headings or titles using the 

Styles gallery on the Home tab. After Mi-

crosoft changed the default line spacing 

from 1.0 (single space) to 1.15, I created a 

style that was single-spaced. That was the 

only change I made to the Normal style, but 

it comes in handy when I want to save 

space. ❖ 

CLEAN YOUR COMPUTER! 
By David Kretchmar,  

Computer Technician 

Sun City Summerlin Computer Club, NV 

Gigabyte Gazette, April 2019  

www.scscc.club/ 

tomburt89134 (at) cox.net 

W indows 10 does a fine 

job of maintaining your 

system, but over time, users 

will tend to accumulate bits of 

http://www.scscc.club/
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 data and programs that serve no purpose 

other than cluttering up your hard drive. 

Files such as documents and pictures re-

siding on your hard drive are unlikely to no-

ticeably slow down your system if you have 

adequate hard drive space. However, soft-

ware that loads every time the computer is 

used will eventually cause a significant drag 

on your system. Many users are running 

smaller solid-state drives (SSD), so clean-

ing files can yield improved performance. 

Look at MSCONFIG 

Type “msconfig” in your search box. Left 

mouse click on the application, and you’ll 

be at System Configuration. Click on the 

Services tab, then click on the square to 

“Hide all Microsoft services.” Review the 

services that are running at startup and un-

check any that you don’t need.  

Click on the Startup tab then on “Open 

Task Manager” and disable all the items 

you don’t need.  

 In MSCONFIG, we are not uninstalling any 

apps, just stopping them from loading. If 

you have unchecked or disabled a process 

you find you need, it is easy to back into 

this area and recheck or enable something.  

Check Your Apps 

Examine which programs or applications 

are residing on the system. Right click on 

the Windows 10 Start button, and then left 

click on Settings then click on Apps. Sort 

the Apps by Installation Date. Start at the 

bottom of the list and on programs you 

don’t use by left clicking on the App then 

clicking Uninstall. 

Remember the Control Panel? 

Once you’re done with removing programs 

in the Apps view, you can review them in 

the Control Panel. The Control Panel’s im-

portance has been degraded by Microsoft 

and it is not as easy to use as it once was. 

You’ll have to type “Control Panel” in your 

search box, click on Control Panel then 

“Programs and features > “Uninstall a Pro-

gram.” You can sort this list more logically by 

clicking on column holders. Remove programs 

you no longer use. You can also locate the 

Control Panel by doing a search in the Set-

tings area. 

Look at Your Downloads Folder 

Your Downloads folder should be at a peer 

level to your Pictures folder and Documents 

folder and is a prime candidate to hold some 

large files that are no longer needed. Your 

Downloads folder might still contain the instal-

lation files for your printer from 2 years ago, as 

well as any other software of other files you 

might have downloaded over the years.  

It is a good start to sort the files in Downloads 

by size to identify which downloads is hogging 

the most space. A sort by date might also re-

veal files that are no longer needed. 

You should review the contents of the Down-

loads folder carefully, since by default any at-

tachments to emails you have viewed, such as 

pictures or PDF documents (as well as any 

software) are saved to this folder.  

It is common for users to download the same 

programs and email attachments more than 

once. You can easily identify duplicate copies 

of downloaded files. Duplicates will have the 

same file name as the original, but the file 

name will be followed by a (1) or (2), etc. and 

of course can be deleted.  

During this review it is a good idea to move 

pictures and documents you want to save by 

moving them to the appropriate folder. This 

might also help you discover duplicates. 

Run CCleaner 

It is now time to clean up little bits and pieces 

by running the newly upgraded version of  
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CCleaner. This program is not going to free a 

significant amount of space, so it is only im-

portant if you are running a small SSD drive. I 

would not bother to run the Registry cleaner, 

since this is very unlikely to yield a perfor-

mance improvement and could cause prob- 

lems with over aggressive cleaning. 

Be sure to uninstall CCleaner after you run it, 

or you’ll be forever plagued by popups. 

The Time-Consuming Part 

Now you’re going to have to do the most tedi-

ous part of the job. Go through individual fold-

ers, such as your photographs, and delete 

blurry or redundant ones. Yes, you want to 

have backups of your favorite photos, but mul-

tiple copies of the same or virtually the same 

photo in the same directory provides little pro-

tection from loss. Digital cameras make it easy 

to take several pictures and most of us have 

saved many more shots of the same subject 

than we really need.  

Your Documents folder also no doubt contains 

many documents that are no longer needed. 

Another massive folder still present might be 

the “Windows.old” folder that somehow wound 

up there. If you’ve recovered any files that 

might have been lost on your last major install 

of a Windows 10 Operating System, just del- 

ete the “Windows.old” folder to free up many 

gigabytes of space. 

Consider Cloud storage 

Cloud storage services such as Microsoft’s 

OneDrive can hold files that might otherwise 

be cluttering your hard drive. You get 5 GB 

of OneDrive storage space with Windows, 

and if you need much more space you might 

have to pop for a subscription to Office 365, 

which provides 1 TB of storage. 

Google Drive is similar to OneDrive and pro-

vides 15 GB of free storage and creates a 

mirrored folder on your hard drive, which 

you can use the same way as OneDrive. 

Google also provides unlimited picture and 

Google document storage, but photos are 

stored at a reduced resolution. 

One More Helpful tool - Wiztree 

Performance only suffers on a mechanical 

drive when it is over half full, and on an SSD 

as it begins to totally fill up. Still, there is 

usually no good reason to keep massive 

files on your C: (boot) drive. To find big files, 

a graphics representation is often the best 

option. 

Wiztree (http://antibody-software.com) is a 

Shareware program that does a remarkably 

fast job of scanning your drive and seeing 

what files are taking up too much space. 

http://antibody-software.com
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1. Download the spreadsheet. 

2. Extract the first names (from column 4) and 

the last names (from column 5). 

3. Create a list with the format (last name, 

first name). 

4. Sort the list and format it with one item per 

line. 

5. Add HTML code so that it displays properly 

on a Web page. 

6. Paste the result onto our site. 

I wrote a 13-line Python program that reduced 

the steps to these. 

1. Download the spreadsheet to my PC. 

2. Call the program with the spreadsheet file 

as an argument, which performs the above 

steps and places the result on my PC clip-

board. 

3. Open the website and paste. 

The program makes keeping the rosters up-

dated much easier and with a greatly reduced 

chance of error. 

I chose Python for this task, because it has 

extensions to read and write to applications 

such as Excel, and Word, download data from 

websites, schedule tasks, and send e-mail, 

see https://docs.python.org/3/py-

modindex.html.  

That there are hundreds of applications is not 

an unmixed blessing, as many are evolving 

rapidly and keeping up can be challenging. 

You’ll be making some Internet searches to 

find the current information. There are many 

tutorial books and articles on Python, for ex-

ample see https://www.python.org/ 

For me, Automate the Boring Stuff with Py-

thon, by Al Sweigart, provided a good intro-

duction to writing programs that access and 

manipulate data in office applications. How-

ever, Python Crash Course by Eric Matthes is 

a better introduction to the language with ap-

plications in computer games, data plotting, 

and Web page design. 

This program creates a graphic to help you 

visualize your drive. 

Note that when I ran Wiztree I identified a 

massive drive image file residing on my 

hard drive. I did not remember creating this 

file, but this happens when you run a back-

up imaging program without attaching a 

destination drive. I have seen this file on 

several computers I have examined, but 

never believed it would be on my system. I 

deleted this group of files and freed a mas-

sive amount of disk space. 

As with CCleaner, you’ll want to uninstall 

Wiztree when you are done with it. ❖ 

    

SOFTWARE LITERACY BEGINS 

WITH LEARNING TO CODE 
By Dick Maybach  

Brookdale Computer Users Group, NJ 

BCUG Bytes, June 2019 issue,  

www.bcug.com 

n2nd (at) att.net 

I f you’re reading this, you probably work 

with computers almost every day, and you 

probably also find yourself repeating some 

tasks many times, not because you enjoy 

them but because they have to be done. Of-

ten, you could reduce the tedium by writing 

a simple program. 

For example, I belong to a club that uses its 

website to manage registrations for its activ-

ities, and we wanted to make available to 

the members a list of those registered for 

each event. 

The registration feature can download its 

data in the form of an Excel spreadsheet, 

but it includes data that we didn’t want to 

make available on our site. It’s of course 

possible to use Excel commands to extract 

and organize the information, but we often 

have several changes each day. Here’s 

what has to be done. 

https://docs.python.org/3/py-modindex.html
https://docs.python.org/3/py-modindex.html
https://www.python.org/
http://www.bcug.com
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As brick-and-mortar bookstores close and re-

duce their inventories, it becomes more diffi-

cult to find good programming books. If I can’t 

find what I need locally, I make an Internet 

search on, for example, “Python Tutorial 

Books,” and I usually find some good guid-

ance on purchases and free books I can 

download. I‘ve found computer-language re-

views in magazines less helpful, as their 

space is too limited for adequate coverage. 

That Python was a good choice for me at this 

time, of course, says nothing about what lan-

guage might be best for you. Learning one 

takes time and effort, and you want to take 

some care in your choice from the scores of 

those available. Some factors that might influ-

ence you are these. 

• What operating systems and hardware 

support it? 

• What are the costs of a development envi-

ronment (editor, compiler, debugger, etc.)? 

• Are tutorials, references, and application 

articles available? 

• Is there an active user community? 

• Is it currently under active development? 

You may find better information in a group or 

publication interested in your application than 

one concerned with computers in general. For 

example, if you want to work with smart phone 

software, you might look to an Android interest 

group. I favor open-source approaches, as 

they reduce the costs. 

Things may not work out, and that’s OK. I 

once spent several weeks learning the Forth 

programming language, and my conclusion 

was, “I never want to do that again.” I don’t re-

gret the effort, as learning is always worth-

while. If we never learn, we just repeat our  

daily lives, and there is a big difference be-

tween 12 years of experience and one year of 

experience repeated 12 times. ❖ 

               * * * * *  

(WYSIWYG WEB WATCH) 

(Continued from Page 7)  

https://www.todayshomeowner.com/video/find-

wood-imperfections-with-mineral-spirits/  

How to install and use Microsoft Office on 

Linux (with a license key, of course). 

https://www.makeuseof.com/tag/install-use-

microsoft-office-linux/  

Still using your kid's birthday as your univer-

sal password? You're in for trouble. Here’s a 

review of password manager software choices. 

https://www.pcmag.com/roundup/300318/the-

best-password-managers  

Kodi was described in an April 2019 newslet-

ter article. Here is a list of 10 legal Kodi add-

ons for free movies. 

https://www.makeuseof.com/tag/best-legal-kodi

-add-ons-free-movies/  

A list of ‘best’ WordPress hosting providers 

recommended by the author. 

https://www.makeuseof.com/tag/best-

wordpress-hosting-providers/  

Backstabbing, disinformation, and bad jour-

nalism: The state of the VPN industry. In the 

Internet era, everyone needs a VPN — just be 

cautious with your choices. 

https://www.pcmag.com/commentary/368081/

backstabbing-disinformation-and-bad-

journalism-the-state  

They don't always get away with it. Here is a 

rundown of cybercriminals who have done (or 

are doing) hard time for their misdeeds. 

https://askbobrankin.com/  

Don't erase, overwrite: Avoid being a person 

who resells or recycles a drive with data  on it. 

https://www.pcworld.com/article/3390742/dont-

erase-overwrite-how-to-avoid-being-that-

person-who-resells-a-drive-with-data-on-it.html  

“The ultimate guide to your PC”: Near the top 

of this article is a link to download the entire 

guide to your PC as a .pdf file — go get it!! 

https://www.makeuseof.com/tag/

download_your_pc_inside_and_out_part_1/ ❖ 

https://www.todayshomeowner.com/video/find-wood-imperfections-with-mineral-spirits/
https://www.todayshomeowner.com/video/find-wood-imperfections-with-mineral-spirits/
https://www.makeuseof.com/tag/install-use-microsoft-office-linux/
https://www.makeuseof.com/tag/install-use-microsoft-office-linux/
https://www.pcmag.com/roundup/300318/the-best-password-managers
https://www.pcmag.com/roundup/300318/the-best-password-managers
https://www.makeuseof.com/tag/best-legal-kodi-add-ons-free-movies/
https://www.makeuseof.com/tag/best-legal-kodi-add-ons-free-movies/
https://www.makeuseof.com/tag/best-wordpress-hosting-providers/
https://www.makeuseof.com/tag/best-wordpress-hosting-providers/
https://www.pcmag.com/commentary/368081/backstabbing-disinformation-and-bad-journalism-the-state
https://www.pcmag.com/commentary/368081/backstabbing-disinformation-and-bad-journalism-the-state
https://www.pcmag.com/commentary/368081/backstabbing-disinformation-and-bad-journalism-the-state
https://askbobrankin.com/spammers_and_scammers_in_the_slammer.html
https://www.pcworld.com/article/3390742/dont-erase-overwrite-how-to-avoid-being-that-person-who-resells-a-drive-with-data-on-it.html
https://www.pcworld.com/article/3390742/dont-erase-overwrite-how-to-avoid-being-that-person-who-resells-a-drive-with-data-on-it.html
https://www.pcworld.com/article/3390742/dont-erase-overwrite-how-to-avoid-being-that-person-who-resells-a-drive-with-data-on-it.html
https://www.makeuseof.com/tag/download_your_pc_inside_and_out_part_1/
https://www.makeuseof.com/tag/download_your_pc_inside_and_out_part_1/
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NOTICE 
The columns, reviews and other expressions of opinion in 

User Friendly are the opinions of the writers and not nec-

essarily those of the Los Angeles Computer Society. 

LACS became a California non-profit corporation on July 

17, 1991. Its predecessor was the UCLA PC Users 

Group. 

COPYRIGHT © 2019 
by the Los Angeles Computer Society, an all-volunteer, 
tax-exempt [IRC Section 501(c)(3)]  nonprofit California 
corporation. All rights reserved. User Friendly is published 
monthly. Subscriptions are included in membership dues. 
Reproduction of any material here by any means is ex-
pressly prohibited without written permission, except that 
other nonprofit User Groups may reprint LACS articles in 
substantially unaltered form if credit is given to the author 
and this publication and an e-mail is sent to  
<editor (at) lacspc.org> reporting the reprint information 
(user group and the name and date of the publication). 
Product and company names are the trademarks of their 
respective owners.  

FINANCIAL REPORT 
A LACS member who wishes to see or has questions 

about our  financial reports may contact our treasurer.   

SPECIAL OFFERS 

Go to the APCUG website https://

apcug2.org/discounts-special-offers-for-user

-groups/ for discounts and special offers for 

User Groups Members. Avast Anti-virus and 

Acronis True Image, and several book, me-

dia and training sites offer discounts includ-

ing the two mentioned below. 

Members can save at the  

Pearson Technology websites:  

InformIT, Cisco Press, Pearson IT Certifica-

tion, Que Publishing, Adobe Press, and  

Peachpit Press.  

Informit.com/user_groups/index.aspx 

Code for print books: ITCOMMUNITY 

Code for eBooks: DIGITALCOMMUNITY 

                  LAUGHING OUT LOUD 

See the latest books on digital imaging and 

photography, gaming, animation, film and 

video, post-production, audio, music tech-

nology, broadcast and theatre from 

Routledge | Focal Press today! They offer 

discounts to User Groups  

members. 

 

                 TECHBOOMERS.COM 

teaches how to use various websites and  

internet-based applications. 

• https://TechBoomers.com 

• https://www.youtube.com/watch?v=O2-

bwYIYu1I 

"This little computer," said the salesclerk, 
"will do half of your job for you." 
 

Studying the machine, the senior VP said, 
"Fine. I'll take two." 

JERE’S TECH TIPS  

For many helpful tips and tricks for all as-

pects of computing see Jere’s Tech Tips at  

https://apcug2.org/jerestips/.  

https://apcug2.org/discounts-special-offers-for-user-groups/
https://apcug2.org/discounts-special-offers-for-user-groups/
https://apcug2.org/discounts-special-offers-for-user-groups/
Informit.com/user_groups/index.aspx
https://www.routledge.com/focalpress?utm_source=shared_link&utm_medium=post&utm_campaign=160701200
Https://TechBoomers.com
Https://TechBoomers.com
https://www.youtube.com/watch?v=O2-bwYIYu1I
https://www.youtube.com/watch?v=O2-bwYIYu1I
https://apcug2.org/jerestips/
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Annual membership Dues: 

Regular New and Renewal,  

     Printed   Newsletter               $ 40 

     Electronic Newsletter         30 

Family-Associate                                           12 

Students                                                                                           18 

Contributor                                                                                  50 

Supporter                                                       75 

Benefactor                                                                        100 

A subscription to User Friendly 

is included with membership.  

Associate members are 

those who live in the same 

household or work at the same 

address as a regular member; 

they do not receive their own 

subscriptions to User Friendly, 

but may read it on the LACS 

website. Students must prove 

full-time status.  

In addition to monthly 

general meetings, 

members enjoy these 

special benefits: 
     —  Monthly Newsletter  
User Friendly. We publish your 
article submissions or free 
classified ads to buy or sell   your 
computer items. 
    —  Get FREE help by phone 
from knowledgeable members 
who are Quick Consultants 
listed in User Friendly. 
    —  Get help by email by  
using our LACSLIST Yahoo  
Group Mail List. Send your  
questions by e-mail to  
lacslist (at) yahoogroups.com  
    —  Receive important news 
and announcements via User 
Friendly and LACS’s Yahoo 
Group e-mail lists. 
    —    Occasional product  
 discounts, special offers, etc. 

                    LACS    New or Renewal Membership Application   

Please bring your dues and this form to a meeting or mail them to: 

Los Angeles Computer Society, 11664 NATIONAL BLVD. #343, LOS ANGELES CA 90064-3802 

 

[   ] New       [   ] Renewal                   Please PRINT Clearly               

[   ] With printed newsletter  [   ] $40.00      [   ] Associate  $12.00     [   ] Student - $18.00  

[        ] With electronic newsletter, not printed  [   ] $30.00    

[   ] Contributor  $50.00        [   ] Supporter $75.00        [   ] Benefactor  $100.00      [   ] Other $______ 

________________________________________________________________________________ 

Name:  First                                                                         Last                                                         

________________________________________________________________________________ 

Name of Associate:   First                                                    Last                          

________________________________________________________________________________ 

Address: 

________________________________________________________________________________ 

City, State, Zip + 4     

________________________________________________________________________________                                             

Email:                                                                                                                              Email of Associate:

 ________________________________________________________________________________ 

Preferred Phone:                                                        Publish Contact Info in Roster            [    ] Yes     [    ] No                         

________________________________________________________________________________ 

Did a member of LACS invite you to join? If so, who? If not, how did you hear about LACS? 

 

                                                                                                                                                                       
                                                                                                                                                                                      

           —  Special Interest Groups
(SIGs) on various topics may be 
created to help you to learn, to 
share interests, and to solve your 
computer problems. 

     —   Information on training, 

swap meets and trade shows. 

     — Occasional Free software 

and computer books, if you re-

view them for User Friendly.  

     —   Rewards for recruiting; 

LACS will extend your member-

ship for three months for each 

new regular member you recruit. 

     —    Annual Holiday Party 

     —     Field trips 

           —    Social Interacting with oth-

ers who have like interests in 

computers and technology. 

       —    Virtual Technology Con-

ferences 

                                                 

Revised: Nov. 2018 ljc 

                        MEMBERSHIP INFORMATION 



Directions to  
General Meeting 
Westchester United Methodist  

Church Fellowship Hall 

8065 Emerson Ave.  

Los Angeles CA 90045 

From the North:  

Take Sepulveda Blvd. SOUTH 

to W. 80th St. Turn WEST/right. 

Go about one mile to Emerson 

Ave. Turn SOUTH/left. Go one 

long block to W. 80th Place. It  

is on the Northwest corner of 

Emerson and W. 80th Place. 

From the South, East or West: 

Take Manchester Ave. to 

Emerson Ave. Turn NORTH. Go 

about eight blocks to W. 80th 

Place. Fellowship Hall is on the 

Northwest corner of Emerson 

and W. 80th Place. There is 

street parking and a small 

parking lot West of the church.  

 

Editor…..…………........... Leah Clark 

Indexer ……….….............Leah Clark 

Podcast Transcriber ... . Irv Hershman 

Photographer……..................    Vacant  

Proofreaders ….......Lance Hegamin,  

    Jim McKnight, Stephanie Nordlinger,  

    and Charlotte Semple 

User Friendly is published by the Los Angeles Computer Society.  

11664 NATIONAL BLVD, #343    LOS ANGELES  CA   90064-3802 

Voice-mail: 310– 398-0366. Web site: http://www.lacspc.org 

FREE! 

Earn 3 months of free  

membership for every new regular 

member you bring in. 

http://www.lacspc.org

